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Warranty and liability

Warranty and liability

Note

Security
informa-
tion

The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These Application Examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these
Application Examples and other Siemens publications — e.g. Catalogs - the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber
threats, it is necessary to implement — and continuously maintain — a holistic,
state-of-the-art industrial security concept. Siemens’ products and solutions only
form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems,
machines and networks. Systems, machines and components should only be
connected to the enterprise network or the internet if and to the extent necessary
and with appropriate security measures (e.g. use of firewalls and network
segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be
taken into account. For more information about industrial security, please visit
http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them
more secure. Siemens strongly recommends to apply product updates as soon
as available and to always use the latest product versions. Use of product
versions that are no longer supported, and failure to apply latest updates may
increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial
Security RSS Feed under http://www.siemens.com/industrialsecurity.
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1 Task

2.1 Solution overview

1 Task

Introduction

This application demonstrates how to deal with the Modbus RTU protocol in the
automation environment of an S7-300 station. It demonstrates the programming of
a Modbus master via CP 341 as well as the programming of a Modbus slave via
ET 200S 1Sl in an S7-300 CPU.

Overview of the automation task

The figure below provides an overview of the automation task.
Figure 1-1

S7-300 -
Automation system Distributed 1/0

-8

The application is to demonstrate the following:
e Configuration of the CP 341 and ET 200S 1SI for Modbus RTU.
e Creation of a flexible Modbus master/slave program in the S7-300.

Description of the automation task

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
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2.1 Solution overview

2 Solution

2.1 Solution overview

Objective of the application
This application demonstrates the following:
e Basics of the Modbus RTU protocol

e Parameterization of a serial communication processor (CP 341, ET 200S 1SI)
for communication with Modbus RTU

e Flexible programming of an S7-300 CPU with a CP 341 as Modbus master for
communication with several slaves

e Programming of an S7-300 CPU as Modbus slave for communication with a
master via an ET200S 1SI module

In the sample project, the CP 341 as Modbus master alternatingly reads two data
words each from the two slaves (ET 200S 1SlI).

The user program of the master and slaves designed for the application of the
function codes 3 and 16 is located in the S7-300 CPU.

The exact function mechanisms of the program are described in Chapter 4.

Display
The following figure displays the most important components of the solution:
Figure 2-1
Engineering station
STEP7 V5.5
S7-300 CPU: CP 341 1Sl 1Sl
program for (RTU (RTU (RTU
Modbus master & master) slave 1) slave 2)
Modbus slaves

__ N\

m ]

a
a
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2 Solution

Advantages

2.2 Required hardware and software components

This application offers you the following advantages:
e Fast introduction to the subject of Modbus RTU with SIMATIC S7-300
e You get encapsulated functions for programming either a Modbus slave or a

Modbus master

Validity

e Software versions from STEP 7 V5.5 SP3 on
e SIMATIC S7-300 CPUs
e CP 341, ET 200S 1Sl

Delimitation

This application does not include an introduction to the subject of SCL

programming.

Basic knowledge of that is assumed.

2.2 Required hardware and software components

The application in STEP 7 V5.5 was generated with the following components:

Hardware components

Table 2-1
Component No. Order number Note

PS 307 5A 6ES7 307-1EA01-0AAQ

CPU 315-2 PN/DP 6ES7 315-2EH14-0AB0O Alternatively, other
CPUs from the S7-
300 spectrum can
also be used.

CP 341-RS422/485 1 6ES7 341-1CHO02-0AEOQ The module with the
RS232 interface is not
suitable for a bus
configuration.

ET 200S 1 6ES7 151-3BA23-0AB0

PM-E DC24V 1 6ES7 138-4CA00-0AA0

ET 200S 1SI 2 6ES7 138-4DF11-0BA0O

BaseUnit 2 6ES7 193-4CC20-0AA0

BaseUnit 1 6ES7 193-4CB20-0AA0

Note If hardware different from that in the sample project is used, the hardware

configuration has to be modified correspondingly!

Master-Slave Communication with Modbus RTU Protocol for S7-300

and ET 200S Systems
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2 Solution

Standard software components

2.2 Required hardware and software components

Table 2-2
Component No. Order number Note

STEP 7 V5.5 SP4 HF11 6ES7810-4CC10-0YAS

S7-SCL V5.3 SP6 6ES7811-1CC05-0YA5

Modbus Master f. 6ES7870-1AA00-0YAO

CP341/CP441-2

STEP 7 V12 1 6ES7822-1AE02-0YAS The STEP 7 V5.5
project was migrated to
STEP 7 V12.

Note Only Chapter 6 "Startup of the application" goes into the differences between

STEP 7 V5.5 and STEP 7 V12. This application is focused on STEP 7 V5.5.

Sample files and projects

The following list includes all files and projects that are used in this example.

Table 2-3

Component

Note

109474714_S7300_ModbusRTU_STEP7_PROJ_v1d1.zip

This zip file includes the
archived STEP 7 V5.5
project.

109474714_S7300_ModbusRTU_TIA_PROJ_v1d1.zip

This file includes the
archived STEP 7 V12
project.

109474714_S7300_ModbusRTU_DOC_v1d1_en.pdf

This document.

For further documentation, for example on the distributed 1/0O ET 200S, please refer
Chapter 8 Related literature.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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3.1 Function mechanisms of Modbus RTU

3 Basics of the Modbus RTU protocol

3.1 Function mechanisms of Modbus RTU

Overview

Modbus RTU (Remote Terminal Unit) is a standard protocol for serial
communication between master and slave.

Other protocols of the Modbus specification such as Modbus ASCII are not
supported by the serial SIMATIC S7-300 CPs.

Master-slave relation

Modbus RTU utilizes a master-slave relation in which the entire communication is
effected from one single master unit. The slaves only respond to the requests from
the master. The master sends a request to a slave address and only the slave with
this slave address responds to the command.

Special case: If Modbus slave address 0 is used, the master communication
module sends a broadcast telegram to all slaves (without receiving a slave
response).

Communication procedure
The communication procedure with Modbus RTU is as follows:
1. The Modbus master sends a request to a Modbus slave in the network.

2. The slave responds with a response telegram in which - if data were requested
- the data are already contained or

3. if the slave cannot process the request of the master, it responds with an error
telegram.

As an example, the following table shows the structure of a telegram if data are to
be read from a or several holding register(s) of the Modbus slave (Modbus

standard).
Table 3-1
Telegram Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5

Request Slave Function Start address (from No. of registers

address code which holding register
on it is to be read)

Valid response Slave Function Length Register data
address code

Error message Slave 0x83 Error
address code

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
Entry-ID: 109474714, V1.1, 09/2017 8
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3 Basics of the Modbus RTU protocol

3.1 Function mechanisms of Modbus RTU

The function code tells the slave which function to execute. Table 3-2 lists the
function codes that can be used with the CP 341

Table 3-2
Function code Function

01 Read output bit

02 Read input bit

03 Read holding register

04 Read input words

05 Write one output bit

06 Write one holding register

15 Write one or several output bit(s)

16 Write one or several holding register(s)

07 Read event bit

08 Check slave status via data diagnosis code /
Reset slave event counter via data diagnosis code

11 Read status word and event counter of slave communication

12 Read status word, event counter, telegram counter, and event bytes
of slave communication

Performance data

No. of units on the bus

Table 3-3
Modbus standard No. of addresses
Modbus RTU standard 247; without repeater, the physical limit is
about 30 units.

In the case of line lengths of more than 50 m, a terminating resistor of approx. 330
ohm has to be installed on the receiving side for interference-free data traffic.

Data length
Table 3-4
Instruction type Function codes Maximum no. per request
(CP 341)
Bit instruction 1,2,3,5,15 2040 bits
Register instruction 4, 6,16 127 registers (words)

The respective upper limits of the modules have to be observed.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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3.2 Configuration in STEP 7 V5.5

3.2 Configuration in STEP 7 V5.5

Overview

STEP 7 allows the configuration of Modbus RTU communication. This section
demonstrates

e which settings have to be made in the hardware configuration and
e which properties the instructions for Modbus RTU communication have.

Requirements

In order to configure and program Modbus RTU communication, the loadable driver
blocks for STEP V5.5 are required first.

These drivers can be found at the following sources:

e Loadable Driver Modbus Master (RTU) for CP 341 and CP 441-2
http://support.automation.siemens.com/WW /view/en/27774018

e Loadable Driver Modbus Slave (RTU) for CP 341 and CP 441-2
http://support.automation.siemens.com/WW /view/en/27774276

e Function Blocks, Examples and User Manuals of the Serial Interface
ET200S 1Sl

http://support.automation.siemens.com/WW /view/en/25358470
Install the packets you need.

The configuration of the Modbus functions depends on the module used. For
detailed information, please refer to the manuals stated in Chapter Fehler!
Verweisquelle konnte nicht gefunden werden. "Fehler! Verweisquelle konnte
nicht gefunden werden.".

Licensing

For communication as Modbus master, a software license is required as well as the
corresponding dongle for the CP 341.

¢ MODBUS software license for CP 341 / CP 441-2
http://support.automation.siemens.com/WW /view/en/13211560

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
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3 Basics of the Modbus RTU protocol

3.2 Configuration in STEP 7 V5.5

3.2.1 Configuration of the CP 341 as Modbus master

Hardware configuration

If the CP 341 is to be operated as Modbus master, the following settings have to be
made in the hardware configuration:

Table 3-5
No. Instruction Remarks
1. Open your project. E“] SIMATIC 300(1) (Kenfiguration) -- M
Change to the
HW Config and select
the CP 341. =0 UR
1 PS5 307 2A
2 CPU 3152 PN/DF
X7 HFJ’/I?'F
A2
MX2PTR Fo.rf 7
M2P2R For 2
3
4 [ CP 341-RS422/485
2. Right-C”Ck and go to B} Assigning Parameters to Point-To-Point Connections - [CP 341-RS422/485 (RO/S4) -- \S.
”Object Pl’opel’ties> File Edit View Options Help
Parameter. A _" and Properties - CP 341-R5422/485 - (R0/54) J J
select the "MODBUS General | ndrmence | B yprmneter | ] Frctoce
Master” prOtOCOL Short Description: CP 341-RS422/485
Som ot
Order No.: 6EST 341-1CHO1-0|
Hams CEETE
Pratocol
Load Drivers
Comment: H:’B
&z P Press Fl for help.
3. Download the Modbus | 'Load Drivers (=25
master drivers to the , , ,
CP by double-clicking Driver version online on module
on the gray "Load Driver name: STWFPATR
Drivers” icon. Driver version: 2E
Diriver werzion offline on pragraming unit
Crriver name: STWFRAT
Driver version: ’T
Downloading to module:

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
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3.2 Configuration in STEP 7 V5.5

No. Instruction Remarks

4. After having double- Make sure that the master is assigned the same communication
clicked on the settings as the slave!
"Protocol” icon you can | Example:
set the communication Protocol ==
parameters in the tabs

"Modbus Master" and General | ModbusMaster | interface |

"Interface”. Speed Character Frame

Baud Fate: Data Bits: Stop Bits: Parity:
9600 | Bitsss ERS | 1 = [even |

Protocol Parameters

Reply Montoring Time:  [2000  ms | [~ apaple Operating Mode Selection at RS485

Cperating Mode: Inteference Suppression J
Muttiplier Character delay time: 1 AZ:I

Cancel | Help |

Protocol @
General | Modbus-Master
Operating Mode Presetting of the Receiving Line
" Full-Duplex (RS 422) Four-Wire Operation " Mone
* Half-Duplex (RS 485) Two-Wire Operation ]

+ Signal R{&) O Vot
Signal RiB) 5 Volt

Cancel | Help

With these settings, break recognition is not possible.

5. Finally load the 11 i
modified hardware m Ball Ej

configuration to your
CPU.

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
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3 Basics of the Modbus RTU protocol

Communication blocks

3.2.2

Note

3.2 Configuration in STEP 7 V5.5

Table 3-6

Element Symbolic name Description

FB7 P_RCV_RK In reading function codes, the response telegram
from the slave is received with the function block
P_RCV_RK (FB7) and the data are stored in the
receive buffer specified at the parameters DB_NO
and DBB_NO.

FB8 P_SND_RK The function block transfers a communication job to a
slave, with the data stored in a source data area.

A detailed description of the configuration is contained in the manual \3\, most of

all in Chapters 6 and 7.

Configuration of the ET 200S 1Sl as Modbus slave

Hardware configuration

If the ET 200S 1SI module is to be operated as Modbus slave, the following
settings have to be made in the hardware configuration:

Table 3-7
No. Instruction Remarks
1. Open your project. The number of bytes defines which "bandwidth" per cycle is reserved in

Change to the

HW Config and select
the 1Sl module in the
ET 200S.

the ET 200S for serial communication of this module.

The number of bytes impacts

e the datatransmission rate

e the modules that can be inserted additionally in the ET 200S
: 1 5| Modbuz Slave

2. Right-click and go to
"Object Properties>
Parameter...".
3. | Adjust your Make sure that the slave is assigned the same communication
communication settings as the master!
parameters. For example:

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
Entry-ID: 109474714, V1.1, 09/2017 13
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3 Basics of the Modbus RTU protocol

3.2 Configuration in STEP 7 V5.5

No. Instruction Remarks
General | Addresses | Identification FParameters |
Farameter Walue
— a 0313 =t =
[£] Enable Module Diagnosis []
[£] Activate BREAK indicator [ ]
[Z] Interface RE485 (half duplex)
[£] Receive Line Initial State R(A) OV R(B) 5V
[£] Operating mode Mormal Operation
[£] Slave address 5
[£] Data flow contral
[Z] Data rate 9600
[Z] Stop bits 1
[Z] Parity even
[£] Expiration character time multiple 1
[£] Time to RTS = off after transmission (ms)
[£] Data output wait time (ms)
[£] Delete receive buffer during CPU startup
4. Finally load the

modif?/ed hardware il ﬁﬁill Ej

configuration to your

CPU.

Communication blocks

Note

Table 3-8

Element Symbolic name Description

FB81 S _MODB By initializing S_MODB (FB81), the 1SI module is set
as Modbus slave and telegrams received from a
master are processed by the function block S_MODB
(FB81).

FB2 S RECV_SI Realize the communication between CPU and

FB3 S SEND SI module; internally, the FBs are used by the function

B B block S_MODB (FB81).

all in Section 3.6.

A detailed description of the configuration is contained in the manual \7\, most of

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
Entry-ID: 109474714, V1.1,

09/2017

14



https://www.automation.siemens.com/mdm/default.aspx?DocVersionId=30303190923&Language=en-US&TopicId=17929094539

Copyright © Siemens AG 2017 Al rights reserved

4 Description of the STEP 7 program

4.1 Overview

4 Description of the STEP 7 program

4.1 Overview

Functions
The S7 program realizes the following functions:

e Communication of the S7-CPU as Modbus master (via the CP 341) for cyclic
reading of two words each from two Modbus slaves.

e Communication of the S7-CPU via the distributed I/O (ET 200S with 1SI
modules) as Modbus slave

The communication program for the master as well as that for the slaves is realized
in the SIMATIC S7-300 CPU.

The sample program can be adjusted to your requirements. Please read Chapter 5
on that.

Program overview

Figure 4-1
DB
FB Master_Data
:.- Modbus_Master
FB Global
Setting Foca!
communication P SND RK
parameters Pa;a:jneters
and data
P_RCV_RK DB
Conversion_
DB_x
Global
DB DB
Para_Slave_x SiEe [DrfE

per slave

cyclic
Global

Master-Slave Communication with Modbus RTU Protocol for S7-300
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4.1 Overview

Blocks and instructions
The following blocks are used in the STEP 7-V12 project:

Table 4-1
Element Symbolic name Description
OB1 CYCLE Contains the main program:
calls the FB Modbus_Master (FB5) and for
each slave the FB S_MODB (FB81). =
0OB100 RESTART e Parameters for the master for ;
communication with the slaves are ©
initialized. 2
e Parameters for the slaves are initialized. a
e The FB Modbus_Master (FB5) is
initialized with a call.
FB5 Modbus_Master A communication module is set as Modbus
master. The function block manages all
communication jobs to a or several Modbus
slave(s).
DB4 Master_Data Contains parameters for the FB
Modbus_Master (FB5) and the buffers for
communication jobs from the master.
DB5 |_Modbus_Master Instance DB of the FB Modbus_Master (FB5) -
c
DB100 CONVERSION_DB_x | Is added to the calling of the FB S_MODB g
DB200 (FB81) and defines - dependent on the S
function code - at which location incoming and | 3
outgoing data are to be stored. é
DB101 Slave_Data_x Data storage for one communication module Q
DB201 (1SI) each. §
DB102 |_S_MODBx Instance DB of the FB S_MODB (FB81) =
DB202
DB103 Para_Slave_x Contains parameters for the calling of the FB
DB203 S_MODB (FB81).
UDT1 Data_for_Master Contains parameters for the creation of a
Modbus telegram.
uDT2 Slave_Para Contains parameters for the calling of the FB
S_MODB (FB81).
FB2 S RECV_SI For communication between the CPU and 1Sl
FB3 S SEND SI module of the distributed I/O. The function
B B blocks are called internally by the FB
S_MODB (FB81).
FB7 P_RCV_RK Communication instruction for receiving data
as Modbus master. ”
Is called internally by the FB Modbus_Master Z_:.g
(FB5). s
FB8 P_SND _RK Communication instruction for communication S
as Modbus master. 2
Is called internally by the FB Modbus_Master *
(FB5).
FB81 S_MODB In each call: an already parameterized
communication module is set as Modbus
slave for communication with a Modbus
master.

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

4.2 Function mechanisms of the FB Modbus_Master (FB5)
42.1 Calling the FB Modbus_Master
Task

The FB Modbus_Master (FB5) manages the communication jobs of the CP 341 to
the Modbus slaves.

Calling and parameters of the FB Modbus_Master

The figure shows the call interface of the FB Modbus_Master (FB5). The
parameters are described in Table 4-2.

Figure 4-2
222
"Modbus Master"
. —EN
PORT
. —MASTER

. —No_Slaves

ERROR—, ..
DB No
. —Comm_Data STATUS—. ..
. —{INIT ENO|—
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

The FB Modbus_Master has the following input and output parameters:
Table 4-2

Parameter Type

Remarks

PORT_MASTER IN:

INT

Start address (LADDR) of the master
communication module; can be taken from the
hardware configuration.

Properties - CP 341-R5422/485 - (R0O/54)
General Addresses | Basic Parameters |

Inputs

Start: @

End: 2N

Process image:

No_Slaves

Number of active communication jobs stored in
the DB Master_Data (Master_comm array).

No_DB_Master_Data | IN:

Block number of the DB Master_Data.

INT
INIT IN: For INIT = TRUE, the communication jobs in
BOOL the Master_comm array the station addresses
of which have the value zero are locked.
For INIT = FALSE, the communication jobs are
processed in the DB Master_Data.
ERROR OUT: ERROR = TRUE if an error is pending in the
BOOL block.
STATUS OUT: STATUS of the block. More detailed
DWORD information is given below.

Output parameter: STATUS

Table 4-3

Status

Description

High Word

Indicates at which station address (at which slave) the status occurred.

Low Word

Status of the block at which the error occurred.

If all station addresses in the DB Master_Data have the value 0, the value of
STATUS is 16#FFFE.
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

422 Initialization

Overview

The "INIT" status is triggered by calling the FB Modbus_Master (FB5) in OB100 in
the first cycle with INIT=TRUE. In the user program itself, the status can be
recalled several times with INIT=TRUE.

In this status, parameters required for the program run are initialized.

Description
Table 4-4
No. Process Remarks
1. Resetting of the REQ input of the FB It is ensured that a positive edge is
P_SND_RK (FB8). created at the control input.
2. Resetting of the counter variables used
in the function block, which are
incremented each time ERROR=TRUE
or DONE=TRUE occurs.
3. Locking of the slaves with the Modbus Address 0 serves as broadcast in
station address=0. Modbus communication.
4, Definition with which slave Communication is started with the first
communication is started. slave the Modbus station address of
which in the Master_Comm array is not
equal to 0.
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

4.2.3 Cyclic processing of the communication jobs

Overview

After successful initialization of the parameters, the FB Modbus_Master (FB5) is in
the status "cyclic processing of communication jobs".

In this status, the communication jobs are sent to the Modbus slaves and the

communication is managed.

Program code: calling of the communication blocks
Figure 4-3

//calculation of the byte-address of the modbus telegram - information
control .DEB NO 5 := (control.number-1)~2&+4;
ffecaleculation of the length of the data of the modbus telegram
IF "Master_ Data".Master comm[control.number].Comm Param.functioncode = 16%3 THEN
survey.length2:=6;
ELSIF "Master Data".Master comm[control.number].Comm Param.functioncode = 16710 THEN
survey.lengthZ:=( ("Master Data".Master comm[control.number].Comm Param.reg number)*2) +6;
END IF;
//call of the FBE P SND ERK
Master_ Instance 5 |

SF := '5'// IN: CHAR

(REQ := control.req master // IN: BCCL

LADDR := PGRE_HASTERE; IN: INT

(DB NO := DE No Master Data/

DBB_NO:= control.DEB NO 5 // I

(LEN := survey.lengthZ/;/ IN:
)z
control.req master := 1;
survey.done master := Master Instance 5.DCONE:; // BOOL
survey.err master:= Master Instance 5.ERROR; // OUT: EOCOL
stat := Master Instance 35.STATUS; // OUT: WORD
f/fcall the FBT P_RCV_RK TO receive
/f the answer of the modbus slave
control.DEE NO R := (control.number-1)*26+10;
Master Instance R |

EN R := 1

LADDR := PORT MASTER// IN: INT

0B _NO := DE No Master Data

,DBB_NO:= control.DBE_NO R
)z
survey.length := Master Instance R.LEN;
survey.ndr := Master Instance R.NDR:
survey.errR:=Master Instance R.ERROR;
survey.statusk := Master Instance R.STATUS;
Description

Table 4-5
No. Process Remarks
1. The input parameters DBB_NO and

LEN for calling the FB P_SND_RK
(FB8) are calculated on the basis of the
current control number.

2. The FB P_SND_RK (FBS8) is called with
the parameters from the active UDT
Data_for_Master.

As response to the sent telegram, the

slave sends the requested data to the
master.

If you want to modify the jobs to the
Modbus slaves, please refer to
Section 5.2.
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4 Description of the STEP 7 program

4.2 Function mechanisms of the FB Modbus_Master (FB5)

received and the data contained therein
are stored in the receive buffer for the
slave (in the DB Master_data,
Master_comm array).

No. Process Remarks
3. The FB P_RCV_RK (FB7) effects that The FB P_RCV_RK (FB7) is always
the response telegram of the slave is called.

Program code: evaluation of the parameters
Figure 4-4

/fanalysis of the output parameters

IF survey.done master OR survey.err master THEN

IF survey.err master THEN

END

fafter there is an error or a done on the function blocks:

//save error and count

control.save number := control.number;
Survey.err_count_ gen:= Survey.err_count_gen +1;
survey.stat_save_comm:=stat;

IF survey.errR THEN

Survey. st,at,us_saveR I Burvey. statusk;
END_IF:

control.req master := 0; //reset the req input of the Modbus Master instruction
"Master Data".Master comm[control.number].Diagnostic.ERROR :
"Master Data".Master comm[control.number].Diagnostic.STATUS:

e done and count

e number for data-transfer

survey.done_count_gen := survey.done count_gen +1;

"Master_ Data".Master_comm[control.number].Diagnostic.ERROR:=0;
"Master Data".Master comm[control.number].Diagnostic.S5TATUS:= 07
control.req master:=0; //reset the req input of the Modbusz Master instruction
IF;

hange Modbus station address

IF control.change = 1 THEN

END

IF control.number < Nao Slaves THEN

WHILE ("Master Data".Master comm[control.number+l].Diagnostic.LOCK) AND (control.number < No_Slaves) DO

control.number:=control.number +1;
END_WHILE:
END_IF;

control.number:=control.number +1;

IF control.number >No Slaves THEN
control.number:=survey.first_unlocked;

END_IF;

IF;

END_IF:
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4 Description of the STEP 7 program

Description
Table 4-6

4.2 Function mechanisms of the FB Modbus_Master (FB5)

No.

Description

1.

If the FB P_SND_RK (FB8) returns ERROR=TRUE, the status is stored, an
error counter is incremented, and the request input is reset.

The resetting of the request input triggers a new communication job in the next
cycle.

If the FB P_SND_RK (FB8) returns DONE, a done counter is incremented and
the request input is reset.

The resetting of the request input triggers a new communication job in the next
cycle.

After ERROR=TRUE as well as after DONE=TRUE, the next element in the
Master_comm array is marked as active.

With the following cycle of OB1, the next communication job is started.
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4.2.4 The UDT Data_for_Master
Overview
The UDT (User Defined Datatype) Data_for_Master contains the information
relevant for the FB Modbus_Master (FB5) about the communication with a Modbus
slave. The Master_comm array in the DB Master_Data consists of UDTs
Data_for_Master.
Structure
Figure 4-5 shows the structure of the UDT Data_for_Master.
Figure 4-5
Address |Name Type
0.0 STRUCT
+0.0| |[Diagnostic STRUCT
+0.0 LOCE BOOL
+0.1 EERCR BOOL
+2.0 STATUS WORD
=4.0 END STRUCT
+4.0| |Comm Param STRUCT
+0.0 address EYTE
+1.0 functioncode BYTE
+2.0 reg startaddr |WORD
+4.0 reg number INT
=6.0 END STRUCT
+10.0| |buffer AREAY([0..7]
*2.0 WORD
=26.0 END STRUCT
Use

The sample project contains an array of two UDTs Data_for_Master in the DB
Master_Data.

The parameters
e address

o functioncode
e reg_startaddr
e reg_number

specify the job of the master for the slave. More detailed information on the use of
the Modbus function codes can be found in the manual \3\, Chapter 6.

If you want to communicate with further slaves or read/write other data areas,
please refer to Chapter 5.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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4 Description of the STEP 7 program

4.3 Function mechanisms of the Modbus slave

4.3 Function mechanisms of the Modbus slave
4.3.1 Calling the FB'S_MODB (FB81)
Task

The function block S_MODB (FB81) receives the Modbus protocol and converts
the Modbus addresses into SIMATIC memory areas.

Calling and parameters

Figure 4-6
"S_-M-O-DB"
.. —EN
.. —LADDR
START
.. —|TIMER
START
.. —TIME
.. —DB_No
.. — OB MASK
.. —CP_START
CP_START
L— -
.. —CP NDR
CP_START
.. —oK B
CP_START
.. —lERROR
.. —ERROR_NR
ERROR
.. —INFO ENO|-
Table 4-7
Parameter Type Remarks
LADDR IN: HW identification (LADDR) of the slave
INT communication module; can be taken from the
hardware configuration.
Properties - 1 5 Modbus Slave (32 B) - (R-/52)
General Addresses | Identification | Parameters |
Inputs
Start: E Process Image:
End: 319
START_TIMER IN: Timer for aborting the initialization of the function
Timer block after a defined period of time.
START_TIME IN: Maximum time that may elapse for the initialization
S5TIME of the block.
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4 Description of the STEP 7 program

4.3.2

Overview

4.3 Function mechanisms of the Modbus slave

Parameter Type Remarks

DB_No IN: Number of the data block that contains the
BLOCK_DB | conversion table (CONVERSION_DB_x).

OB_MASK IN: In the case of TRUE, access errors in the /O area
BOOL are masked and in the case of write access to

nonexistent 1/0, the CPU does not STOP.

CP_START IN: Starts the initialization.
BOOL

CP_START_FM IN: Is set by the FB S_MODB (FB81) itself. Has to be
BOOL set to O during initialization.

CP_NDR OUT: Indicates if data from the master have been written
BOOL in the slave data area.

CP_START_OK OUT: CP_START_OK=TRUE if the initialization of the
BOOL function block has been successful.

CP_START_ERROR | OUT: CP_START_ERROR=TRUE if the initialization of
BOOL the function block has not been successful.

ERROR_NR OUT: Error number
WORD

ERROR_INFO OUT: Additional error information
WORD For more information about ERROR_NR and

ERROR_INFO, please refer to the manual \7\,
Blocks

In the sample project, the following data blocks are required for calling the FB
S_MODB (FB81):

e CONVERSION_DB_x

e Slave Data_ x

e |_S MODBXx

e Para_Slave x

For slave 1 these are the data blocks 100-103, for slave 2 the data blocks 200-203.

DB |_S_MODBXx

The data block |_S_MODBX is the instance data block of the FB S_ MODB (FB81).

The data block is generated automatically as soon as the FB S_MODB (FB81) is
called.

DB CONVERSION_DB_x

The data block CONVERSION_DB_x informs the FB S_MODB (FB81) at which
location - dependent on the function code used - the data received from the master
are to be stored.

Figure 4-7 shows the structure of the CONVERSION_DB_X. The entry marked in
red applies to the function codes 3 and 16 used here (and also to function code 6
which is not used here).
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4 Description of the STEP 7 program

4.3 Function mechanisms of the Modbus slave

Also relevant are the parameters DB_MIN and DB_MAX since these restrict the
access to the data blocks.

Figure 4-7
+0.0| |FCO1_MOD_STRT_ADR_1 |WORD WELEE0
+2.0| |FCO1_MOD_END ADR_1 |WORD WELEEFF
+4_.0| |FCO1_CNV_TO _FLAG A |WORD WELEE0
+e.0| |FCO1_MOD STRT ADR 2 |WORD WElefloo
+8.0| |FCO1_MOD END_ADR_Z |WORD WELGELFF
+10.0| |FCO1_CWV_TO_COUTEUT WORD WELE£0
+12_0| |FCO1_MOD STRT_ADR 3 |WORD WELleg200
+14_.0| |FCO1_MOD END ADR 32 WORD WELe$2FF
+1&._0( (FCO1_CHV_TO_TIMER WORD WELE£0
+18.0| |FCO1_MOD STRT_ADR 4 |WORD Wglegz00
+20_0| |FCO1_MOD END ADR 4 WORD WELEE3FF
+2z_ 0| (FCO1_CHWV_TO_COUNTER |WORD WELE£0
+24.0| |FCOZ_MOD_STRT_ADR_5 |WORD WELEE0
+26.0( |FCOZ_MOD END RDR S |WORD WELERFE
+28_0| |FCOZ_CHV_TO_FLAGZ B WORD WELEE0
+30_0( (FCOZ2_MOD _STRT_RDR & |WORD Wgleglo0
+32_0| |FCOZ_MOD END_RDR & WORD WELEE2ZFF
+34_0| |FCOZ_CHWV_TO_INPUT WORD WEle0
+36.0| fFCo3_06_ 14 DB _NO WORD WELEECD |
+38.0( [FCO4_ DB NO WORD WELGECo
+40_0| |DB_MIN WORD WiElegCo
+42_0| |DB_MAX WORD WglegCo
+44._0| |FLAG MIN WORD Wgleg0
+46_ 0 (FLAG MRX WORD WELEEFF
+48_0| |OUTEFUT_MIN WORD WELE£0
+50_0| |CUTEPUT MR WORD WELEEFF

In the sample project, the data of the function codes 3 and 16 are stored in the
data block Slave_Data_1 (DB101), according to the specification in
CONVERSION_DB_1, orin Slave_Data_2 (DB201), according to the specification
in CONVERSION_DB_2.

Slave _Data X

In the data block Slave_Data_x, a slave stores the data received from the master
(with function code 3).

If data are read from the master (with function code 16), the data stored in
Slave_Data_x are sent to the master, according to the specification in
CONVERSION_DB_x.

DB Para_Slave_ x

In the DB Master_Data, the parameters for interconnection with the inputs of the
FB S_MODB (FB81) are stored.

The relevant parameters are initialized upon CPU start in the OB RESTART
(OB100).
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4.4 The DB Master_Data

4.4 The DB Master_Data

Overview
In the DB Master_Data, data for the FB Master_Modbus (FB5) are stored that are
required for Modbus RTU communication.
Structure
Figure 4-8 shows the structure of the DB Master_Data.
Figure 4-8
Addreas Name Type
a_a STRUCT
+0.0| |[Master comm RRRRY[1..2]
*26_0 "Data_for Master™
+52.0( |Master INIT BCOOL
+52.1( |Master ERROR BCOOL
+54_0 [Master STATUS DWORD
Use
Table 4-8
Name Data type Use Remarks
Master_comm Array[1..2] of For the use of the UDTs Parameters are used in
"Data_for_Master" | Data_for_Master, please refer | the FB Modbus_Master
to Sections 4.2.4 and 5.2. (FB5).
Master_INIT BOOL Are interconnected with the
Master ERROR BOOL input and output parameters
Master STATUS WORD of the FB Modbus_Master
- (FB5).
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5 Configuration

5.1 Modifying communication settings

5 Configuration

Overview
This chapter provides support if you want to modify the STEP 7 project.
The following adjustment options are documented:

¢ Modifying communication settings such as the baud rate of the Modbus master
and the two Modbus slaves

e Modifying existing communication jobs
e Adding further communication jobs to the program

e Adjusting the receive buffer size in order to send or receive data larger than 8
words

5.1 Modifying communication settings

Overview

Your Modbus master and your Modbus slaves need to have identical
communication parameter settings to be able to communicate with each other.

The communication parameters for the CP 341 as well as for the ET 200S modules
1SI are set in the HW Config.

Procedure for CP 341 and ET 200S 1Sl

Proceed as follows to modify the communication parameters of your
communication modules:

o for CP 341, please refer to Section 3.2.1
o for the 1SI module, please refer to Section 3.2.2

5.2 Modifying existing communication jobs

Overview

The sample project contains two communication jobs on the basis of which the
Modbus master alternatingly reads cyclically 2 words of data each from the two
Modbus slaves.

This section describes how to modify the parameters for the communication jobs.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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5 Configuration

5.2 Modifying existing communication jobs

Procedure
Table 5-1
No. Instruction Remarks
1. Open the OB RESTART (OB100). EHE S.'-"-F'ru:ugrliamm['l] 05100 FESTART
g S”E - FuNE 5_RECV_SI
wsEnE | g a3 5_SEND_SI
2. Adjust the move commands in the Name Meaning
first two networks to your address Modbus slave address of the
requirements. Thus change the slave with which communication
parameters of the Master_comm is to be effected
array in the DB Master_Data. functioncode Function code used. The sample
project is tested with
If you want to change the size of * :f;g{e":”te data in holding
the registers to be read/written, e 16#10: read data from
please refer to Section 5.4. holding register
reg_startaddr Start address of the read/write
access
reg_number Number of registers to be
read/written
3. Download the OB to your CPU
and restart the CPU.

Note

The data the master receives from the slave or sends to the slave are stored in
the DB Master_Data in the buffer of the corresponding communication job (an
element of the Master_Comm array).
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5 Configuration

5.3

Overview

Description

5.3 Adding further communication jobs

Adding further communication jobs

If you want to have more than the two existing communication jobs processed by
the master, the sample project has to be modified.

A differentiation is to be made

e whether only an additional communication job is to be sent to an existing slave
or

e an additional slave is to be programmed, for which then also a communication
job is to be created on the master side.

Via the No_Slaves input, the FB Modbus_Master is informed how many
communication jobs it has to process. For each communication job, a UDT has to
be created in the Master_comm array in the DB Master_Data.

If a slave is to send as well as receive data, it is recommended to expand the
Master_comm array by an additional job. The same applies for the communication
with another slave.

Table 5-2 lists the parameters that need to be set for communication with a slave.
Figure 5-1

Address (Name Type
0.0 STRUCT
+0.0| |[Diagnostic STRUCT
+0.0| |LOCE BOOL
+0.1| |ERERCR BOOL
+2.0( |sTaTus WORD
=4.0 END STRUCT
+4.0 omm_Param STRUCT
+0.0 addres=s EYTE
+1.0 functioncode BYTE
+2.0 reg startaddr |WORD
+4.0 req number INT
=6.0 END STRUCT
+10.0| |buffer ARRAY[0..7]
*2.0 WORD
=Z26.0 END STRUCT
Table 5-2
Variable Function Remarks
address The Modbus station address Enter the station address of the slave
of the slave. configured in the HW Config.
[£] Slave address E
functioncode Indicates the kind of request. The sample project is designed for the
use of function codes 3 and 16.
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5 Configuration

53.1

Note

5.3 Adding further communication jobs

Variable

Function

Remarks

reg_startaddr

Indicates at which register
address reading or writing is to
be started.

reg_number

written.

Indicates the number of
registers that are to be read or

the communication to the respective slave in operation.

Procedure for Modbus master

Via the parameters ERROR and STATUS it is possible to read out the status of

Table 5-3 describes the procedure for adding a new communication job to the
existing communication jobs, for example to another slave.

Table 5-3

No.

Instruction

Remarks

Open the DB Master_Data.

Add a new element to the
Master_Comm array in the DB
Master_Data.

Master comm

"Data for Maater"™

> LERRY[1..3]

Add new networks in OB100, in
which you set the parameters

e address (take the station
address of your slave from the
HW Config)

e functioncode

e reg_startaddr

e reg_number

of the added array element.

For more detailed information on the meaning of the
individual parameters, please refer to Chapter 5 or to the

manual \3\.

In OB1 and OB100, increment the
input parameter of the FB
Modbus_Master (FB5) No_Slaves
by 1.

Download your project to the CPU.

Now your Modbus master
additionally processes the added
communication job.
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5 Configuration

5.3 Adding further communication jobs

5.3.2 Procedure for Modbus slave

If you want to program a slave, you need to adjust your user program as well as
the hardware configuration.

HW Config

Add a new ET 200S SI module in the HW Config. For setting the parameters of the
module, please refer to Section 3.2.2.

User program

Table 5-4
No. Instruction Remarks
1. Create a new DB Para_Slave (for example,
with the number 303).
2. Create an element of the data type Hane Type
"Slave_Para" in the DB.
- STRUCT
Para Slave_3 |"Slave_ Para"
3. Add new networks in OB100, in which you set
the parameters
e LADDR (take the start address of the
input parameters from the HW Config)
e CP_START=1
e CP_START_FM=0
of the newly created DB.
4, Create a new CONVERSION_DB_x block (for | If you only use the function codes 3 and 16,
example, DB no. 300) and modify the initial you have to
values of the DB as desired. e assign the number of your buffer DB to the

variable "FC03_06_16_DB_NO"

e set the variables DB_MIN and DB_MAX
such that the number of the buffer DB is
included in their range.
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5 Configuration

5.3 Adding further communication jobs

No.

Instruction

Remarks

Copy one of the Slave_Data_x blocks and
change the number of the DB in the properties
to the number specified in the
CONVERSION_DB_x.

In the sample program, a buffer of 2 words is
sufficient since no send or receive jobs with
larger amounts of data are issued.

For larger jobs, please refer to Section 5.4.

Call the FB S_MODB (FB81) in a cyclic OB
and transfer the identical parameters of the
DB created in the DB Para_Slave_x (under
1.).
The following parameters have to be assigned
individually:
e START_TIMER

Use a free timer resource.
e START_TIME

A time of S5T#5S is sulfficient.
e DB_NO

Specify the number of the
CONVERSION_DB created under 4.

¢ OB_MASK
Masking; is TRUE in the example.

DBZ _DEW100
"Comm _
Data".

Slave[3].
LADDR —— LADDR

START
T4 — TIMER

. \-J"-.;rviw"'--ﬁ"x-»'“\ ,"k

Download your project to the CPU.

The slave is now ready for communication
with the master.
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5 Configuration

5.4 Adjusting the receive buffers

54 Adjusting the receive buffers
Overview
The sample application reads two words from a slave upon one request. The
buffers used in the program have a size of two words.
If you want to read or write larger amounts of data, you have to make the
modifications described in Section 5.2 and additionally you have to enlarge the
buffers used.
Procedure
Table 5-5
No. Instruction Remarks
1. Open the UDT1
Data_for_Master and change the
"buffer" array to the desired size.
2. Open the DB Master_Data. Name Type Initial val|Comment
Resolve the time stamp conflict STRUCT
by selecting the respective line Master comm |ARRAY[1..Z]
"Data_for_Master" in the ‘Data—
variables detailed view and then staug ~ OpenBlock S
the context menu command STAT1 STRUC| Update Declarations
"Update Declarations". STAT2 BOOL |
STATZ BOOL Object Properties Alt+Return
3. In the DBs Slave_Data_x, Name Type
change the "buffer" arrays to the STRUCT
size already used under 1. buffer RRAY [0 7]
|WORD
The ET 200S 1Sl can send a maximum of 110 registers per
job or receive a maximum of 109 registers.
Information on the maximum size of a write/read job can be
found in the manuals \3\, \4\, and \7\ in the chapters on the
Modbus function codes.
4. Download all blocks to your
CPU.
Now you can issue even larger
send and receive jobs.
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6.1 Hardware configuration

6 Startup of the application

6.1 Hardware configuration

Overview

The figure below shows the hardware configuration of the example.

Figure 6-1

Engineering station
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S7-300 CP 341 ET 200S 1Sls
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[u]
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rerfer to
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[e]s]e]eTeTele)
J0000T0

H bobbooo

24

230V

RS485

PN/IE

The tables describe the hardware configuration procedure of the project.
Please observe the regulations for the configuration of an S7 station.

Hardware configuration of the SIMATIC S7-300 station

Table 6-1
No. Instruction Remarks
1. Insert the power supply, CPU, and CP inthe | Do not forget to insert the backplane bus
corresponding rack. between CP and CPU.
2. Wire the CPU and CP with the power supply. | Mind the correct polarity!

Connect your power supply with the power
grid (230V AC).

4. Connect the CPU to your engineering station | A connection via MPI or PROFIBUS from
with STEP 7 V5.5 via Ethernet. your PG to the CPU is also possible.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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6 Startup of the application

Hardware configuration of the ET 200SP

Table 6-2

6.1 Hardware configuration

No.

Instruction

Remarks

1.

Insert the front module, the power module,
and the 1SI modules with base unit as well as
the termination module in a top-hat rail.

Observe the instructions in the manual \6\!

Master-Slave Communication with Modbus RTU Protocol for S7-300
and ET 200S Systems
Entry-ID: 109474714, V1.1, 09/2017

2. Connect the front module with the SIMATIC
S7-300 via an Ethernet cable.
3. Connect the 1SI modules of the ET 200S with | Note
each other and with the CP 341 of the In the case of lengths of more than 50 meters
SIMATIC S7-300 (see Figure 6-2). your Modbus bus requires two terminating
resistors.
4. Connect the ET 200S to the power supply of
the power supply module.
Figure 6-2
CP341 ET200S 1Sl
1]
=i ot
7
6
5 RIT (A)- ®
T @ 5
[N
3 RIT (B)+ s
2 NS
—1 Em[ny
=@z PE
4 R (AT (A) - Input
Inputfoutput
5 - - Mode: Half duplex
& - - Terminals
T - - 1 RIT (A)-
8 GND - 2 RIT (B)+
9 T(B)+ Output 8 PE ground
10 |- -
11 |R(BYT (B) + Input
Inputfoutput
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6 Startup of the application

6.2 Hardware configuration in STEP 7 V5.5

6.2 Hardware configuration in STEP 7 V5.5

Configuration of the ET 200S

Table 6-3

No. Instruction Remarks
1. Open STEP 7 V5.5. Edit Ethemet Node

Search for "Nodes accessible online". Ethemel node o
TO th|s end, navigate to "PLC> Edlt Ethernet . Modes accessible onling
NOde> Browse. . -u. MAC address: I Browse... I

Your ET 200S station is now recognized.

2. Select your ET 200S station and confirm with Your station is clearly recognizable by the
"OK". MAC address.
3. Enter the following device name used in the Aedgdzizarzie
prOjeCtZ Device namne: ‘\M151-3PN I Assign Name I
IM151-3PN
Confirm the action with "Assign name".
The S7-300 station is how assigned the
PROFINET name of your engineering station.
Configuration of the SIMATIC S7-300 CPU
Table 6-4
No. Instruction Remarks
1. Open STEP 7 V5.5. Edit Ethernet Node
Search for "Nodes accessible online". Ethermet nde
. . . Modes accessible online
To this end, navigate to "PLC> Edit Ethernet AL
Node> Browse...". e [ Bowe ]

Your SIMATIC S7-300 station is now
recognized.

Select your SIMATIC S7-300 station and
confirm with "OK".

Your station is clearly recognizable by the MAC
address.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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6 Startup of the application

6.3 Retrieving and downloading the projectin STEP 7 V5.5

No. Instruction Remarks
3. Enter the following IP address used in the Set IP configuration
device for your station: & Use P
IP address: 192.168.0.2 s I parameters
Subnet mask: 255.255.255.0
Confirm the action with "Assign IP IP address: [192.168.0.2
Configuration". —
The S7-300 station is now assigned the IP ]
address of your engineering station. Subnet mask: |255'255'255'D
" Obtain IP address from a DHCP server
|dentified by
(v i
Chent 1D
Azzign IP Canfiguration I
6.3 Retrieving and downloading the project in STEP 7 V5.5

Retrieving the project

Table 6-5
No. Instruction Remarks

1. Load the file "109474714 classic_S7-
300_ModbusRTU_CODE_V10.zip" to a local
directory on your PC.

2. Open STEP 7 V5.5 and select "File>
Retrieve".

3. Browse to the storage location of the project
directory and select it with a double-click.

4. Select a destination directory for unpacking the | ' sslect destination directory ==
project. -1, 57HSTS -

By clicking "OK" the project is retrieved.

. 57LBS
] STMANUAL
-+ 1 sTmap

m

I aK I Cancel Help
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6 Startup of the application

6.3 Retrieving and downloading the projectin STEP 7 V5.5

Downloading the project to the CPU

Table 6-6
No. Instruction Remarks
1. Make sure that your engineering
. . . Internet Protocol Version 4 (TCP/IPvA) Properties T
station is located in the same subnet (r ) Prop (S8 =
as the S7-300 CPU. General
Exam ple' You can get IP settings assigned automatically if your network supparts
IP address: 192.168.0.251 this capability. Otherwise, you need to ask your network administrator
for th igte IP settings.
Subnet mask: 255.255.255.0 " appropriate T setings
() Obtain an IP address automatically
(@ Use the following IP address:
1P address: 192 . 168 . 0 . 251
Subnet mask: 255 .255.255 . 0
Default gateway:
2. | The PG/PC interface is set via " et PG/PC Interface - [
"Options> Set PG/PC Interface..." to
the local Ethernet card connected Access Path | LLDP / DCP | PNIO Adapter |
with the CPU.
Access Poirt of the Application:
STOMNLINE (STEP7)  —> TCPAP -> Intel{R) PRO/1000 MT-N..
(Standard for STEP 7)
Interface Parameter Assignment Used:
|| TCP/P > IntelR) PRO/I00O MTAN..
[ TCP/IP - Intel(R) PRO/1000 MT-
BRI TCP/IP(Auto) - Intel(R) PROA100C | Copy...
B TS Adapter = Nelete
:‘—| 1 3
(Assigning Parameters to Your NDIS CPs
with TCP/IP Protocol (RFC-1008])
Interfaces
Add/Remove: Select...
s ][t ]
- i X == —
3. Select your SIMATIC S7-300 station .E A pen Object e Effﬂm corfigurat
by right-clicking on it. Open "PLC> ey . ok
Compile and Download Objects". c”t Ct”l*c
. e opy T+
A dialog for compiling and — ——
downloading the project is opened.
Delete Drel
PLC 3 Download
Print N Compile and Download Objects...
4, Check all check boxes and start the
process by clicking on "Start".
After successful downloading, a
report is opened.

Master-Slave Communication with Modbus RTU Protocol for S7-300
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6 Startup of the application

6.4 Hardware configuration in STEP 7 V12

No. Instruction Remarks
5. If blocks have not been transferred, aster
download the blocks manually. Open Object Ctrb+ Alt+0
To do this, select all blocks in the Cut Ctrl+X
block directory and select "PLC> Copy Ctrl+C
Download" in the context menu. Paste Cirl+V
Delete Del
Insert New Object
PLC Download
6.4 Hardware configuration in STEP 7 V12
Configuration of the ET 200S
Table 6-7
1. Start the TIA Portal V12 in the project view. ~ 1z Online access

Search for "Nodes accessible online".

To this end, navigate to "Project Tree> Online
Access> [Your_Ethernet_Adapter]> Update
accessible devices".

Your ET 200SP station is now recognized.

» (R USE [57USE]

# [ COM [RS232/FFI multi-master cable]

v [H COM <2 [RS232/FFI multi-master cable]

» [ PLCSIM VS x [PHIIE]

+ [ 7 Intel(R) PROI1 000 MT-Netzwerkverbindung
p¥IUpdate &

project:
IM151-3PN
Confirm the action with "Assign name".

The S7-300 station is now assigned the
PROFINET name of your engineering station.

2. Now navigate to "[Your_ET200SP_Station]> ~ [ im151-3pn [192.168.0.1°
Online & diagnostics”. yaf Online & diagnostics: 1.
In the graphical area of "Online & diagnostics", o
select "Functions> Assign name".
= Functions
Assign IF address 2
'
Reset to factory settings
3. Enter the following device name used in the

1.

FROFIMET device name:

2.

l_ Assign name

im151-3pn|

Master-Slave Communication with Modbus RTU Protocol for S7-300
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6 Startup of the application

Configu
Table 6-8

ration of the SIMATIC S7-300 CPU

6.4 Hardware configuration in STEP 7 V12

No.

Instruction

Remarks

1.

Start the TIA Portal V12 in the project view.
Search for "Nodes accessible online".

To this end, navigate to "Project Tree> Online
Access> [Your_Ethernet_Adapter]> Update
accessible devices".

Your SIMATIC S7 station is now recognized.

~ [ Online access
¥ [ USE [STUSE]
» [ COM[RS232/PPI multi-master cable]
¥ [ COM 2= [RS232/PFl multi-master cable
» [ PLCSIMYS x [FNIE]
- tﬂ Intel(R} PROM 000 MT-Metawverkverbindu
g Up

date accessible devices

2. Now navigate to "[Your_S7_Station]> Online « [ 57-300 [192.168.0.2]
& diagnostics”. LA Online & diagnostics:
:jn the graphical Iarea of "Online & » [ Program blocks
iagnostics", select "Functions> Assign IP » [ Technology obiects
address". - b
+ Functions
Settime
Firmware update
Assign name
Reset of PROFINET interfac...
3. Enter the following IP address and subnet

mask in the input fields:

192.168.0.2.

255.255.255.0

Confirm the action with "Assign IP address".

The S7-300 station is now assigned the IP
address of your engineering station.

IP address: 192 _ 168 . O

ka

Subnet mask: 255 . 255 . 255 . 0

[T Use router

Router address: 192 168 .0 2

| Assign IP address

Master-Slave Communication with Modbus RTU Protocol for S7-300
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6 Startup of the application

6.5

6.5 Retrieving and downloading the projectin STEP 7 V12

Retrieving and downloading the project in STEP 7 V12

Retrieving the project

The following table states the procedure for retrieving the STEP 7 project.

Table 6-9
No. Instruction Remarks
1. Load the file "109474714 TIA_S7-
300_ModbusRTU_CODE_V10.zap12"to a
local directory on your PC.
2. Start_ the TIA P_ortal in the project view. Select T4 Siemens - PtP_CM_MV340_S7300
"Project > Retrieve".
| Project |Edit View Insert Online Option
If there is already a project opened, it is closed J NEW...
when the appearing prompt has been 7 (¥ Open... Crl+0
confirmed. Migrate project...
Close Cerl+w
H save Ctrl+S
Save as... Ctrl+Shift+S
Delete project... Ctrl+E
Archive...
5 Card Reader/lUSB memory »
5 Memory card file »
3. Navigate to "109474714_TIA_S7-
300_ModbusRTU_CODE_V10.zap12" and
open the file.
4, Select any project storage location. * ] PtP_Modbus
By clicking "OK" the project is retrieved and ‘;«. add new device
opened. .
ﬁg-h Devices & networks
» [ PLC_1 [CPU 1516-3 PN/DF]
b [gf Common data
b Eﬂ] Documentation settings
r r:m Languages & resources
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and ET 200S Systems
Entry-ID: 109474714, V1.1, 09/2017

42




Copyright © Siemens AG 2017 Al rights reserved

6 Startup of the application

6.5 Retrieving and downloading the projectin STEP 7 V12

Downloading the project to the CPU

The following table states the procedure for downloading the STEP 7 project to the

CPU.
Table 6-10
No. Instruction Remarks
1. Make sure that your engineering station is ) )
located in the same subnet as the S7-300 Internet Protocol Version 4 (TCP/IPv4) Properties E

CPU.

Example:

IP address: 192.168.0.251
Subnet mask: 255.255.255.0

General

You can get IP settings assigned automatically if your network supy
this capability. Otherwise, you need to ask your network administri
for the appropriate IP settings.

() Obtain an IP address automatically
(@ Use the following IP address:

configuration to your S7-1500 CPU via the
"Download to device" button.

After the download, a message appears,
informing that the download process has been
completed successfully.

IP address: 192 . 168 . 0 . 251
Subnet mask: 255,255,255 . 0
Default gateway:
2. Compile the project via "S7-1500> Compile" or . T
via the corresponding icon. E LRIt =
In the inspector window, a message appears,
informing that the compilation has been
completed successfully.
3. After error-free compilation, download the

Master-Slave Communication with Modbus RTU Protocol for S7-300
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7 Operation of the application

7.1 Monitoring

-

7.1

Operation of the application

Overview

Monitoring

When having activated the sample project, your CPU cyclically processes the user

program.

In that, data with a length of 2 words from the slaves are read from the DBs

Data_Slave_1 and Data_Slave_2.
The data read by the master are stored in the array

"Master_Data".Master_comm[1].buffer or "Master_Data".Master_comm][2].buffer.
For a better monitoring of the actions of the user program, the variables table

Modbus_Overview is provided.

Variables table Modbus_Overview

The following table indicates which information can be taken from the watch table.
The watch table can be adjusted to your own project.

Table 7-1

Variable

Remarks

Master_Modbus

..].stat_save_comm

If an error occurs, the value of the status is stored here.

..].done_count_gen

Counts the number of successful calls of instructions in the FB
Modbus_Master (FB5).

..]J.err_count_gen

Counts the number of error messages of the instructions in the FB
Modbus_Master (FB5).

[...].STATUS Output parameter STATUS.

[...].STATUS Stored parameter status of the 1st communication job.
[...].STATUS Stored parameter status of the 2nd communication job.
[...J.INIT Input parameter INIT.

[...].number Indicates with which slave in the array of Master_Data

communication is currently (to be) effected.

Slaves

.].CP_START_OK

Initialization of slavel successful

.].CP_START_ERROR

Initialization of slavel not successful

.].ERROR_NR

Slavel: status saved in the case of an error

.].CP_START_OK

Initialization of slave2 successful

.].CP_START_ERROR

Initialization of slave2 not successful

—_—— | ————

..].ERROR_NR Slave2: status saved in the case of an error
Data
[...].buffer[0] First word of the buffer for communication with slavel
[...].buffer[0] First word of the buffer of slavel.
[...].buffer[0] First word of the buffer for communication with slave2.
[...].buffer[0] First word of the buffer of slave2.
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7.2 Data reading from Modbus slave to Modbus master

7.2 Data reading from Modbus slave to Modbus master

This chapter describes how to transmit data from the slaves to the master.
The sample program reads data from the Modbus slaves to the Modbus master.

Table 7-2
No. Instruction Remarks
1. Activate the application as
described in Chapter 6.
2. Open the watch table |
. an | 6| ]|
Modbus_Overview and select W et
the option "Monitor variable”. You now see the actual values of the watch table.
When having activated the application successfully, the
variable "done_count_gen" is incremented consistently.
3. Enter any value for the slaves in | :"Master_Data"Master_comm{1] buffer(] HEX W#16#0000
the "Modify value" column. {"Data_slave_1"butfer(n] HEX WH16#0000 V1620005
aster_Data".Master_comm([2].buffer]0] HEX WH16#0000
| ata_Slave 2-butfer(0] HEX WH16#0000 W#16%0001

In the figure, the values correspond to the station addresses
of the slaves.

4. By clicking on the "Modify _I_H G [an
variable" button the values are 6)“'? i’ . 11

applied to the slaves.

5. By processing the sample “Master_Data” Master_comm[1] buffer{0] HEX WHIE#0005
project, the master now reads “Data_Slave_1" buffer[0] HEX WHIGH0005 o/  W#IBH000S
the entered data from the slaves | Master DataMaster commizlbuffers]  HEX — Wiiex0001 e
and stores them in the buffer "Data_Siave_2"bufferl0] HEX | wesn001 ) es1e#0001
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8 Related literature

8 Related literature

Internet links

The following list is not complete and only represents a selection of relevant

information.
Table 8-1
Subject Title
\1\ Reference to the entry http:/support.automation.siemens.com/WW /view/en/
109474714

\2\ | Siemens Industry Online http:/support.automation.siemens.com
Support

\3\ SIMATIC S7-300/S7-400 http://support.automation.siemens.com/WW/vie
Loadable driver for point-to-point | w/en/1220184
CPs: MODBUS protocol, RTU
format, S7 is master

\4\ SIMATIC S7-300/S7-400 http://support.automation.siemens.com/WW/vie
Loadable driver for point-to-point | w/en/1218007
CPs: MODBUS protocol, RTU
format, S7 is slave

\5\ SIMATIC S7-300 Establishing http://support.automation.siemens.com/WW/vie
and parameterizing point-to- w/en/1117397
point connection CP 341

\6\ SIMATIC ET 200S distributed http://support.automation.siemens.com/WW/vie
I/O Interface Module 151-3 PN w/en/30598131
(6ES7151-3AA23-0AB0)

\7\ SIMATIC ET 200S serial http://support.automation.siemens.com/WW/vie
interface modules w/en/9260793

\8\ S7-SCL V5.3 for S7-300/400 http://support.automation.siemens.com/WW/vie

w/en/5581793

9 History

Table 9-1
Version Date Modifications
V1.0 04/2013 First version
V1.1 09/2017 Correction in Table 2-1 and Figure 6-2
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